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Word processing for reports and essays  
It is assumed that students will already possess some basic word processing skills (normally 
using MS Word) when they arrive at university.  
 
We will therefore concentrate on how Word can be used to produce a specific piece of work 
you might be required to do, such as an essay or report. Tasks are given in this document 
as doing helps you understand better.   
 
Note: these notes refer to Word 2010 but are also to a great extent applicable to Word 2007.  

 
The document is in plain text with minimal formatting: using this for the tasks will save you 
having to do a lot of typing and also help demonstrate the importance of suitable formatting.  
We will begin by looking at inserting breaks and adding page numbering in a document. 
Breaks allow you to add new blank pages anywhere in a document; they are also useful in 
separating chapters and sections from each other.  
 

Inserting breaks  
Page Breaks and Section Breaks are found on the 
Page Layout tab, under the Page setup group. 
 
You must distinguish between page breaks and 
section breaks.  A page break inserts a break (and 
inserts a new page) which will keep text separated 
each side of the break.  This makes it useful for 
organising chapters and sections in a document.   
 
However, only by using Section breaks can you 
apply different layouts to different areas of a 
document.   
 
Your main section break options are Continuous 
and Next Page. 

The Continuous command inserts a section break and starts the new section on 
the same page. A continuous section break is useful for creating a formatting 
change, such as a different number of columns, on a page. 

The Next Page command inserts a section break and starts the new 
section on the next page. This type of section break is especially useful for 
starting new chapters in a document. 

 

Task 1  

a) You will first need to download this document at:  

http://www.gla.ac.uk/services/it/training/courseresources/ and download the file named 
Art History (yes it is dull but you needn’t read it – we use it as the copyright belongs to 
this university thus plagiarism is not an issue).  

c) Save the document to your My Documents folder. Remember to do this with any files 
that you download or they may be lost later, along with any work you did on them.  
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You will now add some formatting to the text. It is assumed you already know enough basic 
formatting for this task. If you require revision read on, if not skip to task 3.  

 

 
 
 

Main text: use a plain font – ignore over-embellished or 
“script” style fonts.  Choose a font size of 11 or 12 for the 
main text: most fonts will look right at that size.   Larger sizes 
should only be used for headings and smaller sizes for things 
like labels or footers.   Note that if the structure of your 
document is very sectionalised (as this document is) a font 
like Arial is fine.  It is plain and legible.  However, for 
documents that have quite long sequences of plain text, it is 

much better to use Times New Roman.   
 

Other text: fonts without serifs - Sans Serif - can also be used as a contrast with a Serif 
font that you use for the main text .  For instance, you could use a font like Arial for 

headings or for other text, which is used occasionally – such as text in tables or in footnotes.  
The difference makes it stand out more. A review of some font options may be seen at: 
www.fonts.com/AboutFonts/Articles/ 
 
Emphasis: we’ve described emphasis by varying font type.  You can also vary font style, for 
instance using italics or using bold.  Launch the Font dialog box from the Font group for 
more font style options.  
 
You should know how to find the menus of Fonts and Font Sizes on the Word toolbar.  
For text which is longer than a brief paragraph, serifed fonts are best as they are easier to 
read. So use a serifed font like Times Roman, Baskerville or Garamond.  
 
Use font size of 12 pt for serifed fonts: this is a comfortable reading size for most – you can 
adjust this if you use a smaller font type.  
 
Different fonts have different sizes but between 10-12 pts should be adequate.  
 
 

Task 2  

a)  At the front of your Word document insert two section breaks, creating two new 
blank pages. At the end of your document insert another new page using a section 
break.  

b)  The first new page will be your title page – you might find it easier to use Insert  
Cover Page but here it’s useful as practice using section breaks.  

c)  Add your name, student ID number as a title on the title page. On the next page put 
the heading “Contents”. On the final page, put the heading, “Appendix”. Save the file.  

Fonts menu  Font size 

Text formatting options are 
found on the Home tab in the 
Font and Paragraph groups. 

You can open dialog boxes for 
these options by clicking on the 
group launch buttons (an 
example is arrowed). 
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Spacing between lines:  
Essays and other work documents are required to 
have line spacing of 1½ to 2 lines. This aids 
legibility.  
 
Spacing between paragraphs and sections:  
A space before or after helps make it clear where 
each paragraph begins. Sections require larger 
spacing and clear headings.  
 
Indentation:  
This is useful for laying out data in columns and 
should always be used for longer quotations in 
your text.  
 
Note: our guidelines are generally useful but make 
sure any work you submit conforms to the 
guidelines laid down by your College or School.  
 
Other formatting guidance can be found at:  
http://www.gla.ac.uk/it/files/itts/publications/introduction_to_word.pdf 

  

 
 
Headings styles  
 
Styles are combinations of font type, font size and paragraph settings which can be applied 
immediately to a word, phrase or paragraph.  Word offers a large selection of built-in styles 
any of which can be modified if it doesn’t fit your needs exactly.  Important also are Heading 
Styles which offer built-in (but hidden) numbering which allows them to be used in the 
creation of a table of contents. 
 

Task 4 

a) Select all of the main text (ignore the title page, contents page, the table and 
references). Click the Paragraph dialog box launcher and set Spacing Before to 6 
pts. This gives an automatic half-line space every time you press the Return key.  

b) If you prefer to have an indented first line in your paragraphs, set it using the Special 
option in the Paragraph dialog box: choose First line and set it to 3 pts (or 0.5 cm).  

c) Set the Line spacing to 1.5 or Double – if you’re not sure what your college/school 
prefers, choose the latter.  

d) Set paragraph alignment for all the paragraphs to Justified. Close the Paragraph 
dialog box.  

e) Go through the document and break up some of the longer paragraphs into two, 
shorter paragraphs (use the Return key).  

f) Check that the changes you’ve made to formatting haven’t affected the text (e.g. by 
disconnecting a paragraph from its heading).  

Task 3  

a) Select the text of your Word document (ignoring the cover page). Change the font of 
the text to Times New Roman, 12 pts.  

http://www.gla.ac.uk/it/files/itts/publications/introduction_to_word.pdf
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Applying Quick Styles 
Apply a style from the Style group which is on the right 
hand side of the toolbar when the Home tab is 
selected. N.B. Character styles will be applied to the 
word in which you have placed the cursor, paragraph 
styles will be applied to the whole paragraph. 
 

 
 
Applying Styles using the Style Dialog Box 

To view all the available styles, click on the Style dialog box 
launcher.   

This will display the list of all the available styles – you can scroll 
through to select a suitable style.  Just click on a style name to 
apply it to an area of text. 

There are also options to create a new style or manage existing 
styles.  If you don’t see the style you require, click Options at the 
bottom of the pane and in the window that opens select All 
Styles. 

When the cursor is placed to the side of a style name, a down arrow 
for a menu appears: this menu includes the Modify option which 

allows you to make changes to the selected Style. 

In the Style Pane click the New Style button which is below the list 
of Styles. You will be presented with a dialog box through which you 
create your new style.  

 

 

Task 5  

a) Select each heading in the document and apply a Heading style to it.  

b) If you have a title on the main content page, make this Heading 1; next level down 
(sections/chapters headings) should be Heading 2; and so on for each level.  

c) Create a space at the start of the document main text and enter a new heading, 
Abstract (make this Heading 2 format). Type in two brief sentences: these can simply 

state who you are and what you are studying at the university. 

http://blogmines.com/blog/images/upload/2011/07/image136.png
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Document information  
Displaying document information is useful both for the student and the lecturer who will have 
to mark the essay/report. There is information about the document – e.g. name, date 
produced, author, etc. – which can be displayed either on a cover/title page or in headers 
and footers (or both if you wish). There is also information about the content you may wish to 
convey to a reader – e.g. footnotes, endnotes, bibliography.  

 

Headers and footers  

Information about the document – e.g. name, date produced, author, etc. – can be displayed 
in headers and footers.  Information about the content, e.g. page numbers, footnotes, 
endnotes, etc. – can be displayed in a similar 
way. 
 
If you select Header or Footer, from the Insert 
tab, a menu of header or footer types will be 
displayed.   
 
Once you click an option, the header/footer will 
be inserted and replicated to every page. All 
you need to do is add text where indicated; 
your changes will be replicated as well.  
 
Note that you can format header and footer text 
just like you would any other. 
 
The Header & Footer Tools/Design tab 
becomes active at the same time.  This contains options for page numbering, moving 
between sections and linking/unlinking sections. 
 

 
 
You may not wish to have the same document information appear on every page. For 
instance you may wish to have introductory material or appendices with different page 
numbering, headers or footers to that of the main document.   
 
You can change this by clicking on the Link to Previous button (in the Navigation 
group) to select or deselect it.  This allows you to ensure that sections you want to have 
different features on are properly separated, so that for instance Landscape orientation 
you wish to limit to one section is not repeated throughout the document.  
 
It also allows you to have different Headers, Footers and Page Numbering in your 
document. 
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Inserting footnotes  
A common feature of academic work (including essays and reports you may have to 
produce) is the use of footnotes for references and other related information.   

To insert a footnote in a document, place the cursor at the end of the 
word or sentence you wish to make a reference from and then select 
References tab  Footnotes group Insert Footnote.   

In the dialog box which opens when you click the Footnotes Dialog 
Box Launcher, you can convert from Footnote to Endnote, and 
choose which numbering format you prefer. 
 

 
 
Note: be aware of the proper method of citing a reference when referring to it in a 
footnote/endnote or in a bibliography. See: http://library.open.ac.uk/help/howto/citeref/index.cfm 
  

Contents lists  
Headings can form the outline for a contents list; 
contents listings are a required part of some course 
work, such as reports and dissertations.  
 
Word will automatically create a table of contents for 
you from text formatted with headings styles or set 
to different levels in the Outline view.  
 
To insert a table of contents (based on heading 
styles) place your cursor where you want it appear. 
 
Click the References tab. Then, in the Ribbon, click 
Table of Contents then Automatic Table from the 
Built-In menu. 

Task 7 

a)  Insert a Footnote referring to one of the references at the end of the document (it 
doesn’t matter if it makes sense here, it’s just an exercise).  

b)  Add an Endnote to one of your paragraphs – when you do this, change the numbering 
format in the Footnote and Endnote window.  

c)  Of course, you’d never use both Footnote and Endnote in the same document. 
Choose one and use it throughout. Save the document.  

Task 6  

a) Make sure your cursor is in the section where your main text content appears. Undo 
the Link to Previous button so that this section is separate from the previous one. 

b) Access the Header/Footer option (Insert  Header and Footer). Put your name 
and school as a header.  

c) Use the Go to footer button in the Navigation group (in Header & Footer Tools) to 
go to the footer. Now put the date on the right hand side of the footer in your Word 
file.  

d) Insert Page Numbers into the same part of your document as you placed your 
Header and Footer (the option for this is in the Header & Footer Tools). 

http://library.open.ac.uk/help/howto/citeref/index.cfm
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Another way of creating a table is the Insert Table of Contents option at the bottom of the 
Built-In menu. 

This will open the older-style Table of Contents dialog box, allowing you to customise a 
dynamic table of contents.   While you are in the Table of Contents dialog box make sure 
that you select the appropriate number of levels to be displayed in your table (e.g. adjust the 
Show Levels number to 4 if you have applied 4 types of heading style.)  

Finally, click OK to insert your table of contents.  
 

 
 
Inserting bullets or numbering 
You will sometimes want to create a list of brief items, clearly marked 
in some way. This can be as a bullet (a simple icon or symbol) or a 
numbering system of some kind.  
 
To add bullets or numbering, simply click the buttons in the Paragraph group on the Home 
tab or choose the Bullet or Numbering menu by clicking on the down-arrow beside the 
appropriate button.  
 

 
 
Bullets are fine for short lists (and where the order does not matter) but longer lists should be 
numbered and you should use numbering too if you have “nested” lists – lists within lists.  

 

Using Tables in Word  
Word lets you create tables in a document.  You can create a brand new 
table and add data to it or, if you have some text arranged in a consistent 
format, e.g. data separated by tabs, you can convert this into a table. 
 
To add a table to your document, choose the Insert tab then the Table 
menu (in the Tables group).  You can drag over the table grid to select 
the cells in your table or choose Insert Table from menu below.  This 
opens a dialog box where you can define your table.   
 
Note the other options in the menu: Draw Table, Convert Text to Table, 
Excel Spreadsheet and Quick Tables. 
 
A useful guide to using tables can be found here: 
www.addictivetips.com/microsoft-office/word-2010-insert-tables-formulas/ 

Task 9 

a) Type in the following list using Bulleted format:  

Old English; Early Middle English; Middle English; Early Modern English  

b) Now select the bulleted list and convert it into a Numbered list. Save your file.  

Task 8 

a)  In Task 5 you applied Heading Styles to all the headings in the main text of the Word 
document.  

b)  Go to the page with the heading “Contents”. Don‟t give this a heading style, simply 
format it Bold.  

c)  Under the heading insert a table of contents. (This is found under References  
Table of Contents). Save your file.  

http://www.addictivetips.com/microsoft-office/word-2010-insert-tables-formulas/
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Text-checking tools 

Spell Checking: choose Spelling and Grammar from the Proofing group on the Review 
tab. The checker will suggest grammar corrections and highlight possible spelling mistakes. 
You can choose to accept a suggested change or ignore it.  
 

 
 
It also permits you to add a new word to the spell check dictionary as you type.  
 
Choose Options from the File tab menu.  

Then choose the Proofing option (left hand menu).  

Click on the Check spelling as you type checkbox.  
 
Thesaurus: Word has a built in thesaurus that can help you.  
Select a word, which you want to find a better option for.  

Choose Thesaurus... from the Proofing group on the Review tab.  

A list of alternatives will be offered. If none are suitable, select one and press the Look Up 
button to see different alternatives.  

When you are satisfied with one, select it and press the Replace button.  
 

 
 

 
 
 
 
 

Task 11  

a)  Carry out a spell check on your Word file.  

b)  Now use Word Count (in the Proofing group) to calculate the number of words.  

c)  Add a line at the end of the document saying how long it is.  

d)  Then save it again and back it up.  

Task 10 

a)  Near the end of the Word document, you will find some data laid out (using Tabs) in 
a table-like format.  

b)  Select the text and data in the first table and then choose Table  Convert Text to 
Table to change this from text to table format.  

c)  Use Table  Insert Table to create a table that the second set of data will fit into.  

d)  Make sure you select all the data for the second table and cut and paste it into the 
table layout that you just created.  

e)  Select each table in turn and add a caption to each of them (Insert  Reference  
Caption).  

f)  Check that the data has been added correctly and then save the document.  
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Printing  
Printing facilities are available in campus computer clusters. See this page for some advice: 
http://www.gla.ac.uk/services/it/forstudents/csce/adviceonprinting/ 
 

Printing facilities are available in campus computer clusters.  To print in Word, select Print 
from the File tab and the following menu (or a very similar one) will appear. Note: printing in 
Word 2007 is a little different – see below.  
 
Select pages to print Print button to start print job Print Properties opens printer options 

 

         
 
Note: there can be complications when printing documents with images in them.  See 
Appendix II near the end of these notes. 
 
Note: many campus printers now give the option 
to print in colour and/or double-sided. Be careful 
if you don’t wish to print in colour as it is more 
expensive than black and white.   
 
Note too that for some kinds of course work you 
are required to print single-sided.  However for 
other work and previews you can save by printing 
double-sided where it is available.  Both options 
are set under Printer Properties. 
 
Note: if you intend to print, double-sided, a 
document which includes cover, insert a blank page after the cover so no text appears on 
the inside of the cover. 
 
How to print in Word 2007: see next page. 

  

http://www.gla.ac.uk/services/it/forstudents/csce/adviceonprinting/
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Printing in Word 2007 
 
You can use the Ctrl + P shortcut to open the Print dialog. The more conventional method is 
to use the Print section of the Office button menu. 
 

 
 
Clicking the Print command in the main menu or the sub-menu will open the Print dialog 
box. Clicking Quick Print will send the document directly to the printer without specifying 
any options. Clicking Print Preview will open the preview window to check how your 
document will look when printed. 
 

 
 
In the Print dialog box you will see the same set of options that are available in the Print 
window for Word 2010. Here, you can choose your printer and print options, e.g. number of 
pages and copies, scaling, double or single sided and so on.  
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Help resources 
 
Most applications offer a Help menu which you can use to remind yourself how to do 
something or find out something new.  We also offer other more advanced courses and you 
can find out more and apply for these from www.gla.ac.uk/services/it/training/ 
 

Printing documents with images 
Use as good a quality image as you can manage to get and is suitable for the purpose. For 
instance very simple images (diagrams, logos, etc) will usually print out fine at low image/file 
size. Even a small/low size photographic image will be acceptable if its only purpose is to 
allow the reader to get a general idea of what something looked like.  
 
However if it is important to show detail – e.g. where an image represents evidence in a 
report or dissertation – then a good quality image (and consequently a large file size) must 
used and this can present problems. A document with several large sized images may be 
slow to save or open and can take a long time to print. Please take this into consideration if 
you are sharing a printer with others (i.e. when using an on-campus cluster PC).  
 
You can reduce file size: by cropping the image to focus on the part relevant to your 
discussion, by reducing its file size or a combination of both. But you should do this using 
an image-editing application. One is available on the CSCE, named IrfanView. There is a 
brief introduction to using this (and more advice on using images) at the IT Training Moodle 
page: access this from http://services.moodle.gla.ac.uk/course/view.php?id=24 
  
If you crop or resize an image using Word's picture editing features all you do is change the 
view of the image – it still exists (at full file size) – and the picture can always be restored to 
its original version. You can use Word's Compress Pictures option to reduce file space 
taken up by images in a Word document. This is most effective where you have a lot of 
images and if some are cropped – you can choose to deleted cropped areas.  

 

http://www.gla.ac.uk/services/it/training/
http://services.moodle.gla.ac.uk/course/view.php?id=24

